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1 Time Estimates
The IT Professional should be able to complete this lab in 90 minutes.

2 Purpose

You will build the foundation for our sample application and learn about
application structure that allows styling your application easily.

You will learn how to create a custom control that has a customizable content
area. You will use the control in the sample application and learn how to display
Notes documents in XPages using form properties and simple data binding.

3 Description

You will create three XPages that provide access to our sample application. You
will prepare some structure for the subsequent exercises and then extend the
existing container control to include a tabbed control and a content area. The
content area allows you to add individual content into it, effectively creating a
new container control type.

Create a profile form (Classic Notes) and map the profile form to an XPage. Add
data binding to the profile XPage to show data stored in the Notes form.

—
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4 Detailed Steps

Create a new XPage Application

1. If Domino is not running, start it now.

Open Domino Designer from the desktop icon and login as Domino Admin/ibm with
password passwOrd.

. Close the Welcome Page and click on Create a New Application from the Home
Page.

| fS’ Home

=3 x

g < i ==
E g ‘ Create a New Application ‘ !3,7 l Open an Existing Application

(% Shortcuts: Press Control + Shift+ L to get a listof all Eclipse shortcuts

4. Select DOM85/ibm as the server and name the blank application xScrapbook.

New Application E
Server | DOME5/ibm | | —ra—
Title wScrapbook
File name  |xScrapbook|nsf @

Encryption...
[] Create full text index: for searching
Server |Loca| M
Template | &3 -Blank- ~
& Template CTS Request DB =
& Template Matthizs Q Schneider
BB Application Library (8)
E Diesign Synopsis
R Discussion - Notes & Web (2.5) M
|:| Show advanced templates
her & design change 4
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5. Click OK.

6. Create three XPages in your Scrapbook application named:
- home
- results
- profile

7. Create one Custom Control named container.

8. Open the container custom control.

In the next step we will add nested panels to the custom control.

Note: A panel translates into a DIV element using the HTML rendering but can contain
additional logic. Panels are commonly used for styling or partial refresh operations.

9. Drag six panels onto the container Custom Control page and then arrange and nest
them as shown below.

Important: make sure to use the names shown:

- Panel: frame
- Panel: header
- Panel: headerlnner
- Panel: main
- Panel: tabBar
- Panel: content

Y ME Page 4 of 26
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The easiest way to do this is using the Outline panel on the left side of the screen.

@) Applications B=HE % [@ Home x " hwPage .  x | B9 hwCon
EE {)“tli"E mﬁ % ..................................................................

= [e] RootDocument
-2 ¥M| Processing Instruction :
IEI" Custom Cﬂﬂtl"ﬂl I .................................................................
Elj Panel: frame
Elj Panel: header
] Panel: headerlnner
= j Panel: main
i Panel: tabBar
El Panel: content

..................................................................

10. Add a Label control into the headerlnner panel and give it a Label of Scrapbook.

(@) Applications I [@» Home " hwPage ... x u—‘j hwContr..

o= Outline == % || Seranbools
RICTADDOON:. oo e s e e e
= [e] Root Document :
727 %ML Processing Instruction

EI-- Custom Control
Elﬁ Panel; frame Design | Source
Ela Fanel: header & : -
=3 panel: headerinner || Properties  x HE Events "|1 Problems (0 items) = |

|

F g abc

E";j Panel: main "= Aol Mame: | label1 |
il Panel: tabBar _Style
"] Panel: content Font Label: | Scrapbook | b

Eadcg_rnuﬁtﬂ— Height: I:IQ Units: IjO
ek Width: e Units ol <

11. Save the custom control. You might receive a message that the automatic project
build has been turned of. Enable it via Project > Build Automatically.

12.  Add your new container custom control — via Drag’n Drop - to each of the XPages
(home, results, profile).
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Work with Stylesheets

13. From the Resources section of the application navigator, double-click on Style
Sheets.

14. Click on Import Style Sheet and browse to
C:\MyLabFiles\XPages\stylesheets\styles.css.

(@) Applications B=3 x [@iﬁ‘. xScrapbook.nsf - Design - Style She...  x H L

H-H =
wScrapbook m
¥Sorapbook.nsf

i E Forms

; ﬁ Views

h—il Folders

= ¥Pages

|E| home

|§| profile

E results

=25 Custom Controls

% container

----- [E Framesets

..... [ Pages

EEI--% Shared Elements

-- Code

% Data

EI Resources

. <
ﬂ AR @ [E Properties HE Events x HE_( Problems {

----- 'El Using Document

: @9 Icon
e
EFI";E Composite Applications &, Basics Application
Application Properties E T Title: xSerapbook

COPYRIGHT IBM CORPORATIdN 2009. ALL RIGHTS ESERVED. IBM ISV & DEVELOPER RELATIONS.



IBM Lotus Notes and Domino 8.5 E

15.  From the Resources section of the application navigator, double-click on Images.
16. Click on Import Image Resource and browse to C:\MyLabFiles\XPages\images.
17.  Import all of the images from this directory. (You can select them all using the Ctrl

key)
@ Applications B=E x [I&iﬁ‘ xScrapbook.nsf - Design - Imz
W E = [ ﬁlmport Image Resource | | Open
xScrapbook H =
¥Sorapbook . nsf
. B.ad{gr.:;ﬁﬁﬂhﬁ.iﬁi.gif. :
bannerLeft.gif
18] xPages bannerRJght..glf
g buttonBlue . gif
B home : ;
i buttonSilver. gif
[ profie ;
- collapse.gif
|:.u results dividerBlue gif
=55 Custom Controls dividerMini, gif
& container divideryellow. gif
----- Hj Framesets expand. gif
""" [ | Pages helpIcon, gif
E_EI--% Shared Elements ibm.gif
-- Code placeholder_female.gif
#-EH Data placeholder_male,gif
EI Resources 3
: E Imagesﬁﬁ?i-_
Files
Applets
=

Next, we will add the style sheet to the container control.

18. Click anywhere on the container control and then click on Style in the Properties
dialog
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19. Click on the Add style sheet to page button.

l% Properties x]ﬁ Events xEEPrublems(Uitems) x-

MNo custom formatting has been added.

Class: | &

e Styles: e % Recently used styles

Property Definition
All Properties

Theme: | &

EAdd style sheet to page;%
[ pisable runtime-applied default style @

20. Select styles.css from the dialog and click OK.

@ Select style sheet to add to this page

{*) Use style sheet from this application

() Link to style sheet from a URL:

| = [
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21.  On the Style tab of each panel (6 panels) map the panel name to the
corresponding named style sheet class.

i — Bl
EI Resources
E Images

Style Sheets

[

[E Properties u][@ Events uHE_g Problems (0 items) =

5= Qutline == %
= [e] RootDocument
7=7 ¥ML Processing Instruction
9--- Custom Control
xp:this.resources
EIE Panel: frame
E BEl Panel; he

= Pane%d@

EIE Panel: main

E Panel; tabBar

----- E Panel: content

Panel
Mo custom formatting has been added.

Data
Style

ty Class: | frame

Fant

Background Styles: % Recently used styles

Margins = 9"51:501& sheets on page
All Properties

@

----- ['{—5 friendsPanel:hover

----- f{'—b\ .header

TIP: Use the Outline to navigate the panels easily.
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22. Go back to the label you added to the headerlnner panel and map it to the class

headerInnerTitle.

EI Resources
: E Images
: Files

] Applets

[E Properties X

[E Events x

Mo custom formatting has been added.

[E_g Froblems (0 items)

Style Sheets Label
LoFR o M Style
5= outline =5 x Font
Class:
= IE Root Document Background :
"‘=7 XML Processing Instruction Margins s,
B--- Custom Contral All Properties

F-  xp:this.resources
B*j Panel: frame
: Bi Fanel; header
Bﬁ Panel: headerInne

........ fing!

-2k Label: label %}é .
Bj Panel: main 1 IS lD

i Panel: tabBar
j Panel: content

| headerInnerTite

% Recently used styles
El@l Style sheets on page

= styles.css

.content

frame
friendsEmail
friendsMame
friendsPanel
JfriendsPanel:hover
header
headerlnner . | |

23. Save the container control and switch to one of the XPages.

24. Use the Preview in Web Browser button to see the results in the browser.

) Mozilla Firefox

File Edit Miew History  Eookmarks Tools  Help

'cu';

[ I: 15[' |http:,l',l'domSS,l'xScrapbook.nsF,I'resuIts.xsp

‘{:? '| |'|Google j::'|

(8] Mast visited P Getting Started .| Latest Headlines

Do you wank Firefox bo remember this password?

laemember ] [Ngver for This Site] [ Mok Mow ] ﬁ

Scrapbook
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Our first XPages

22. Open the container custom control.

23. Drag a Tabbed Panel (from Container Controls) onto the page and use the Outline
to place it into the tabBar Panel control.

5% putline == X

E [E] Root Document
-9 ¥ML Processing Instruction
EI-" Custom Control
¥pithis.resources
=i j Fanel: frame
Ba Panel: header
1j Fanel: headerInner
B'j Panel: main
BE Fanel: tabBar
@

ﬁ Panel: content

The tabbed panel needs to have 3 tabs: Home, Profile and Results.

24. Right click on tabbed panel and select Append Tab.

! Lotus,
New Tk hlcou: Tak T
Select Page
< Undo Reparent Node Ctrl+Z
& Redo Cirl+
s % cut Chlax b
LH Copy Cirl+C
[ Paste Cirl+v
pesign (86
esign | A Delste Delete P
P Ly item
IE tUBE Select Tabbed Panel Container
Select Active Tab Contents
ﬁ:l'a_sb_e-d Remove Active Tab
Style Insert Tab
Font | Append Tab |
Background |
It et o
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25. Use the outline to select the tabs and get to their properties and name:
- the first tab homeTab with a label of Home
- the second tab profileTab with a label of Profile

- the third tab resultsTab with a label of Results

[@ Applications =3 x l [6@) Home x |25 *container - Custom Control X
EE {)utline EE % I ...............................................................................
4
= IE Root Docum :
T2 WML Procf Qutline ptruction _—
=Bl custom (-:an . Home = Profle | Resuits
F-  xp:this.resources |'
Elj Panel: frame '
Elj Panel: header :
Elﬁ Panel: main
Ea FanelEhBar: 00000 W e e S S
: EJE| Tabbed Panel: tabbedPanell
E Tab Panel: homeTab
f| Tab Panel: profileTab - |
; -] Tah Panel: resultsTab Design | Source
[T Panel: content = Properties  x HE Events x ][Eu Problems (0 iterns)
Tab Panel
Mame: | resultsTab |
Style
._F-:-:nt Label: | Results| | &
Background [w] vigible <
Marnins
i == 1Y "~ _. |
COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED. IBM ISV & DEVELOPER RELATIONS.
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26. Drag an Editable Area control (from Core Controls) into the content area. Drop it

where facet_1 is in the picture.

[ﬁ' Home x Hﬂ *container - C. %

[ﬂ searchForm-... “ﬁ-_,“ profileForm ...

[% searchResult..

Design ! 55'»"33 |

|E Properties x |[E Events x "E_g Problems (0 items)  x |

Visible <

27. Create three more Custom controls:

- searchForm
- profileForm
- searchResults

|
_E‘E’FP_IE_{‘P_ Controls added to this editable area are treated as children of the custom control instead
All Properties of the host page.
Mame: | callback1 |
Facet name: | facet_1 | &

TIP: Add some temporary content to these controls to be able to see their proper

operation.

COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED.
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28. Add each of the new custom controls to their own XPage Editable Areas as

follows:

- searchForm into home

- searchResults into results
- profileForm into profile

Example: Drag and drop the searchForm custom control onto the green circle on

the home XPage.

=3 conta... x

[ﬂ searc.. x

29 profi.. |

9 searc.. x “ *home.. x | a1

| Scrapbook |

s 10

i 3

[E& Controls  x
[ Select
E Other...

i:{El Core Controls
Edit Box
Rich Text

[£] Multiine Edit Box

[@ Data x

[} Button

[Z]] List Box

] Combo Box
[+#] Check Box
£~ Radio Button
&3 Link

akc’ Label

Diesign :-'SBQ.IEE |

N

[E Properties x

[E Events x

[B_._ Problems (0 items) |

Custom Cuntrt;l_
MName: |

_All Properties
— | [visble ¢

29. Use the preview button to preview the home page.

COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED.

?ﬂ Container Controls

i Panel
% Repeat

[0l Indude Page
] Table

] view

£ Data Table
[ Tabbed Panel
=] Section

i % Custom Controls

\\

[Ewe searchForm
e profileForm
[ searchResults

[He container
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30. Change the URL to see each page, e.g. home.xsp, results.xsp & profile.xsp.
Note that you will connect up the navigation tabs in Exercise 14.

Scrapbook

Home Praofile Results

searchFarm

Scrapbook

Home Profile Fesults

profileFarm

Scrapbook

Home Frofile Results

searchResults

Bring Data into Play

31. Create a new Notes form named profile. Add the following fields:

- FullName (Computed Text) Formula: @Trim(FirstName + " " + LastName)

- Email (Text)

- TimeZone (Text)

- AboutMe (Rich Text)
- Gender (Text)

- Country (Text)

- FirstName (Text)

- LastName (Text)

- DOB (Date Time)

b OMAS - =

COPYRIGHT IBM CORPORATION 2009. ALL RIG

RESERVED.

IBM ISV & DEVELOPER RELATIONS.



IBM Lotus Notes and Domino 8.5 E

The result should look like this:

| @) Applications BH=8 x [-@ii\ xScrapbook.nsf- Design -Forms ~ x H profile - Form  x ]
ST
1 Profiles _‘_\_
M T Email (Text)
| oS Profiles Complete -
- (" TimeZone (Text)
®pages 1

A P AboutMe (Rich Text)
e
= F
Coney (T Comty
- views o
e Festtme (T |_Fetame
£ Custom Controls LastName (Text)

[E Framesets

) Pages DOB (Date Time)| DOB

+ % Shared Elements
L ) [P

COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED. IBM ISV & DEVELOPER RELATIONS.
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32. Onthe Form properties for On Web Access, use Display XPage instead
and set it to the profile XPage.

Form o == 7 X
A la|lfsflm| =& |=2|

Fomulas inhert values from

selected document
Inherit entire selected document
COn Creat
TR into rich ted field:
On Open Automatically enable Edit Mode
Show cortext pane
On Close Present mail send dialog
Display XPage instead |profile -
On Web
Access
Data Source Options Browse
Default data connection
Default metadata object

COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED. IBM ISV & DEVELOPER RELATIONS.
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33. Create a new view named “profiles” with the view selection formula
SELECT form=""profile”

and the following columns:
- FullName (Sorted Ascending, Sortable / Click to Sort — Both)
- TimeZone
- Email

Map the column values to the previously created fields from the profile form.

34. Create some documents in the Notes client with the profile form. You can
accomplish this by opening the Scrapbook application and selecting Create >
profile from the main menu.

35. Preview the view in the browser and open a document from the view (which
will be empty other than our header).

©3 profiles - Mozilla Firefox |._||E|E|
File Edit Wew History Bookmarks Tools  Help

- h |: it} | hkbp: fidom@sxScrapbaak.nsf[2E01 7FSe0032 17 - | ([G]- e

|_E| Maost Wisited ’ Getting Started |5 | Latest Headlines

4@Previous =¢MNemt 2pExpand = Collapse O Search

profiles

FullName + TimeZone Email
Max Muster GMT  mrn@roustermanns. de

4=Previons = Next  2pEzpand = Collapse O, Search

Done

36. Open the profileForm custom control and remove any temporary text you
entered.

e
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37. On the Data tab of the Properties dialog, add a Domino Document data
source.

i1

wscrapbook
¥&orapbook, st

@ Folders Design] m'
- [] xPages [E Properties x HE Events x ][E_i. Problems (0 items) x]
=25 Custom Controls
H oo L
E SRR Custom Control Data sources:
..... 2 profiler Data
H oo
- E gearchForm Style
“ 1 searchResults =
----- [E Framesets .
..... [] Pages Background
[+ % Shared Elements Margins
" Code Resources
B pata —— :
% Resources Havigakion = Diomino Vie
7 Composite Applications Property Definition Domino Document
LIEE Application Properties I"'“ All Properties
w

38. Choose profile as the form.

JE Properties x "E Events xU@ Froblems (0 items) x]
ISR Data sources: Data Source: Domino Document
B |
QOCUMEn .
Style Mame: document1
Eont Application:
e (& Current xSerapbook.nsf
Margins ) other
Resources
| MNavigation
Prof Definition Default action:
J:.)erty — After you define data sources, you can
| Design Definition drag elements from the Data palette on to Parent ID: &
All Froperties the page to bind data.
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39. Click on the All Properties tab in the Properties dialog. Expand the data\data
entry, then expand the dominoDocument entry and select onsave for the
computeWithForm option.

[E Properties x [E Events x ][& Problems (0 items) =
Custom Control Property Value
Data = basics
Style binding
Font qeateFDrm
dir
Background dojoParseCnload
Margins dojoTheme
Resources :d ded
S oade
Navigation navigationRules
Property Definition pagelcon
All Properties f:r%' pageTite
—;.IXD rendered
resources
= data
i acl
a.;:"‘-f{_EI data
L “IS [= dominoDocument [0]
(9 action
computeDocument
computeWithForm onsave [nall>
concurrencyMode ":ﬁ'lb b
databaseMame onload L,
dDCL.II'I'IEI'Iﬂd ...................................... i . B T——
formiMame : I

40. Save the custom control.

41. Select the Data palette from the right side of the screen.
Note: If the Data palette is not visible, select the arrow beside the Controls
tab and select Data.

- ||% Controls  x n..-..-'ﬂ
[ﬁ& Sei.é_g '
% Oﬁ.'I-EF. iE

188 Core Controls e

Edit Box

L i
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42. Enable the Select Controls dialog box button.
— ]
& Data =5

Sy

| —|
|Sn.=-_|n.=-_ct Controls dialog box (Enabled)
| ]

43. Select all the field bindings except for Full Name and DOB (use Shift to select
multiple).

[@ Data X | v .._T..a':_bl'-
=

Data source: | document1 " |

lI__al FullMame [Text]
Email [Text]
I | TimezZone [Text]
Abouthe [Text]
IE! ] Gender [Text]
ERIEN Country [Text]
RIE | Firsthiame [Text]
LastMame [Text]
--[Ta] DoB [dateTime]

44. Drag & drop all the selected field bindings to the profileForm page in the
design editor.

b=

) - s R — |
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45. Inthe helper dialog change the following control types:
- About Me: RichText
- Gender: Combo Box
- TimeZone: Combo Box

@ Select Data Bound Controls

(i) Click an item to edit the label and control.,

Select a control to add to the page:

Label Control

Email: Edit Box

Time zone: Combo Box

About me: Rich Text

| Gender: | Comba Box b

Country: Rich Text ¥

First name: Computed Field =

i Combobor I8
List Box —
Date Time Picker b7

Add Control Options

[ ] Add submit button to generated code
[ ] add messages contral to generated code

[ save these settings as the default for future Data palette operations

[ oK ] [ Cancel

46. Click on OK.

f QRN+ \N\=
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47. Reorder the row contents using drag & drop (in the Outline) to group related

fields together.
.F-i.l'.s;tnj.:;a.ﬁﬁé;g|l.=.i;s.1:.h.lﬁ.ﬁ1.é .................. | ...................................
Last e §.|I;;':;s.1.:[.\-ia.|i1.1;=_; .................. | ...................................
o |Err|a|I ........................ | ...................................
‘Gender:  lGender~|
Camﬁ}r . .gll.?:t.:.u.r;t.r.y; .................... | ...................................
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48. Right click inside a cell in the resulting table and choose to append 3 rows.

Select Page

B @] b 7 < UndoText Change crl4z |,

& Redo

58 cut Ctrl-+X
Bh Copy Cirl+C
[ Paste Ctrl+v

32 Delete Delete

Table Select 4

Insert Row Above

Insert Row Below

Insert Column to the Left
Insert Column to the Right

Append Row(s)...
Append Columnisj. ..

Delete Selected Rows
-------------------------- Delete Selected Columns
Delete Special. ..

49. Drag a Label control (from Core Controls) to the first column in the first
additional row and make the Label DOB.

<. i : 1111
| Design | Source
E Properties  x "E Events -"-"E_f. Problems (0 items) = |

1
2t/ Label Mame: [ label 1 |
Style
= Label: | oe | ©
Background Height: l:l & Units; i
Margins - i
ki Width: ;| ¢ Units: ¢

50. Drag a Date Time Picker control (from Core Controls) to the second column
in the first additional row.

b=

) =1 R — |
COPYRIGHT IBM CORPORATION 2009. ALL RIGHTS RESERVED. IBM ISV & DEVELOPER RELATIONS.
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51.  From the Data tab in the Properties dialog, bind the picker to the field DOB
and check that the display type is set to Date / Time and the Display format to

Date only.

S ' | @

Design | Source '

= Properties  x "E Events [Eg_\ Problems (0 items) x | H

_Ediiz_Box—l Bind data using: Dieplay type: |Datef|'|me P | 4

Data (®) Simple data binding ) Javasaipt () Advanced Display type options for DatefTime
D indi

Validation FeR Display format: | SRS ~ | [

Type Ahead Data source: |document1 v |

Style Use date/time picker pop-up &

Bind to: |poB v|
Font Date style: |Short (10/5/09) v| ¢
Background ) s —
. Default value: l:l & Tirne style: Default (1:28:45 PN
Margins
All Properties Pattern:

52. Preview the XPage for your control in your browser (note that, although you
can complete the form, you can't save it since we don't have action buttons
yet).

‘ Scrapbook

Home Frofile Results
Firstname:
Lastname:
Email
Time zone v
0 gt g Db s BS|iEEE S EEEE - £~ Font ~| gize -
Ahaut me
Gender, v
Country:
DoB
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5 Summary

In this exercise you built the foundation for our sample application and learned about
application structure that allows you to easily style your application.

You also learned how to create a custom control that has a customizable content area.
You will use the control in the sample application. You learned how to display Notes
documents in XPages using form properties and simple data binding.

Foln - N
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